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Introduction 

Overview 
This document will discuss the setup and use of the Purchasing module. The Purchase order module is its own 
module which is included in the core programs. Accounting set up must be done prior to using the purchase 
order module. This document will not cover the accounting set up. Additional questions or training is available 
from your EFI-PrintStream support staff. 

 

Contact Information 

EFI Support 

US Phone: 855.334.4457 (first select option 3, then press option 8, then press option 1) 

US Fax: 415.233.4157 

US E-mail: printstream.support@efi.com  

Regular Service Desk hours are 8:00 AM to 7:00 PM Central Time, Monday – Friday. Outside of these hours, 
you may leave a voice mail message and an on-call support representative will be paged. Response time is 
based on the severity of the issue. 

Note For problems involving infrastructure (i.e., computers, networks, operating systems, backup software, 
printers, third-party software, etc.), contact the appropriate vendor. EFI cannot support these types of 
issues. 

EFI Professional Services 

US Phone: 651.365.5321 

US Fax: 651.365.5334 

E-Mail: ProfessionalServicesOperations@efi.com 

EFI Professional Services can help you perform EFI software installations, upgrades, and updates. This group 
can also help you implement, customize, and optimize your EFI software plus offer a range of training options. 
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Functions 

System > Preferences 
To setup purchasing preferences, navigate to Functions > System > Preferences. 

 

Databases Menu 

 Select ONLY if the database is setup as multi company or multi plant 

 Will allow up to 9 plants or companies 

 If checked, can easily switch between plants/companies 
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Purchase Order Reports 

Print 

Item #: Displays Inventory Item Number on Purchase Order. 

Item Code: Displays Inventory Item Code on Purchase Order. 

 

 

By Default Print X Copies 

Enter how many copies should print each time the PO is sent to the printer. 

PO: Use Paper Description - No Plant Code definition in description on PO 

Select to display Plant Code in item description. 

Cleared does not display Plant Code in item description. 

Screens \ User Interface 
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Confirm Exit from Application 

If selected, the system will produce a warning message upon exiting: 

 

Initial Screen 

PO Search: This option will default to the search screen upon opening the purchase order module. 

New PO: This option will default the opening screen to a new purchase order entry screen. 

Blank: This option will default the opening screen to just the tree. 

 

Data Entry 

 

 

Copy First Line Item Due Date: This option will copy the due date entered in the first item of the purchase order 
to subsequent lines. The date can be changed. 

Default to X days from today: This check box, if selected and a number is entered, will automatically fill in the 
line item’s DUE DATE field with the date the number of days from today that is entered. The date can still be 
overridden. 

Copy Job Details to line item Desc: If this check box is selected, the PO line item will contain the Job Title from 
the corresponding job if the line item is a job-related purchase. 
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System > Copy Line Notes 

 

 

This utility copies from the NOTES table the Header Notes to the ORDERINFO table and/or the Line Item Notes 
to the ORDERLINE table. 

 

 

 

Select the Copy Header Notes and/or Copy Line Notes check box(es) then click the Copy Notes button. 
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System > Report Format 

 

To select the default Purchase Order format, click the Default Report button and save. To edit/create new PO 
formats, see Functions > Reports > Reports. 

 

System > Print Setup 

 

Note: This feature is in development. 
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System > Switch Company Plant 

 

If multi-company/plant then, you can switch between companies/plants. 

 

 

Utility > Mark Purchase Order as Closed 

 

Mark Purchase Orders as Closed allows the user to mark outstanding purchase orders as closed. An 
outstanding purchase order is a purchase order that has been received, but not AP invoiced. 

This utility has consequences if not used properly. Please see the ramifications for the different purchase order 
types. 

This utility is password protected. Contact PrintStream support for assistance. 
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Inventory purchase orders – When an inventory purchase order is received into PrintStream, the quantity of 
the item as well as the value per the purchase order price will be updated. The general ledger is not updated with 
the value of this purchase until the AP invoice is entered. If this utility is used on an inventory purchase order, the 
only way the general ledger will be updated to reflect this purchase is if 1) a journal entry is created to debit the 
inventory asset account or 2), a miscellaneous AP invoice is entered and coded to the inventory asset account. 

Job related purchase orders – When a job-related purchase order is received into PrintStream, the costing 
against the job is updated based on the value on the purchase order. If the AP invoice is not entered prior to the 
final AR invoice is created for the job, a dummy invoice (cost accrual), will take place on the final AR invoice to 
accommodate the outstanding purchase order. If this utility is used on a job-related purchase order, the dummy 
AR invoice will remain on the Dummy AP Invoice report. This report is the subsidiary for the AP without Invoice 
general ledger account. The only way this report can be cleared is to enter the AP invoice to the job-related 
purchase order. Therefore, the dates for this report will have to be changed to only reflect a current range, or a 
manual calculation will be required to back-out the value of this outstanding purchase order. It is NOT 
recommended to use this utility on job related purchase orders. Instead, enter an AP invoice into 
PrintStream, associate it to the job-related purchase order, enter a miscellaneous item to this invoice and 
allocate the miscellaneous line to the same expense account impacted during the dummy invoice process. 

Miscellaneous purchase orders – This utility does not have any adverse effect on miscellaneous purchase 
orders. 
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Load Uninvoiced 

To use this utility 

1. Select either the Use Due Date or Use PO Date option. 

2. Define the From and To date range. 

3. Click Load Uninvoiced. 

 The grid will load based on the criteria entered. 

4. Click in the gray box located in the far-left column to select all purchase orders, or select purchase 
orders individually. 
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Mark Zero Amount 

The Mark Zero Amount option will select the purchase orders that have a $0.00 value. 

 

 

Close Marked 

After the purchase orders have been selected, click Close Marked to close selected PO’s. A reload of 
uninvoiced PO’s will refresh the grid. 
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Print List 

Select Print List to generate a report of the listed PO’s in the display grid. 

 

The report below can be printed and/or exported. 

 

 

Fix Incomplete Data 

The Fix Incomplete Data option will confirm the ORDTRANS table is updated with the information the purchase 
order has been marked as cleared, in the event a purchase order marked as cleared continues to show on an 
open purchase order report. 
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Utility > Delete this PO 
A purchase order can be deleted as long as it has not been received or AP invoiced. 

 

 

 

Search and select (highlight) a PO then select Utility > Delete this PO. A confirmation message will then 
appear. 
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Reports > Reports 
 

 

Purchase Order 

To print or preview a PO 

1. Select the Binocular icon to the far right of the Report Name field. 

 A report selection window opens. Double-click to select the desired PO format report. 
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2. Enter the PO number or click the Binocular icon to the far right of the PO #. 

 

  

3. Click Print or Preview to print or view the PO. 
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 Clear: The Clear button will clear the selections. 

 View Report Design: Select the PO Report Name then select View Report Design to open the report 
designer tool. 

 

  

 The report designer tool will open the selected report for editing. For documentation regarding this 
feature contact your PrintStream support team, ask for the DexExpress Report Designer doc. 
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Multiple Purchase Order 

To print and/or preview multiple PO’s, use the filters below to return a list of PO’s. 

 

 

Load Grid: To view the list of PO’s, then check the PO’s to Print and/or Preview. 

 

 

Preview and Print: To print or preview the selected PO’s. 

Clear: The Clear button will clear the selections. 
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Inventory Stock On Order 

Stock on Order Report – this report shows the status on all paper items which are currently on order. It allows 
you to filter by PO date range and for all items, a specific item or by a specific vendor. Selecting the Include 
Items not Linked to a Job check box will include any PO’s that were ordered for inventory rather than for a 
specific job. 

To print and/or preview Inventory Stock On Order report, use the filters below to return a list. 

 

 

Load Grid: To view the list, then click Print and/or Preview. 
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Preview and Print: To print or preview the selected PO’s. 

 

 

Clear: The Clear button will clear the selections. 
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PO Monitor 

To print and/or preview Purchase Order Status report, use the filters below to return a list. 

 

 

Job Delivery Date Range: Date range is actually entered based on PO due date range not job delivery date. 

Job Status: Check for Not Final Shipped. 

Not Ordered: Displays a list of materials on jobs which have not been ordered. 

Final Delivered: Displays a list of PO’s which have been flagged as Finally Delivered. 

Waiting for Rcpt: Displays a list of PO’s which have not been received. 

Partial Delivered: Displays a list of PO’s which have partial delivery status 

All of the above selection types can be filtered by any of the following as well: CSR, Activity Code, Customer, 
Sales Rep, Job Number, Product Type, Vendor, and Estimator. 
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Load Grid: To view the list, check the lines to report on, then click Print and/or Preview. 

 

 

Preview and Print: To print or preview the selections. 

 

 

Clear: The Clear button will clear the selections. 
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PO Reports 

 

Overdue PO Report: Lists all PO’s that have not been received as final. It can be sorted by PO#, PO Date, 
Vendor Name or GL Code#. 

PO Receipts Accrual Report: Lists all PO receipts which have not yet been AP invoiced or dummy invoiced, for 
a specific date range. It can be sorted by PO#, PO Date, Vendor Name or GL Code#. This report is used to 
determine numbers for an AP accrual entry at month end. 

PO Without AP Invoice Report: Can be filtered for final and partial receipts, using specific date ranges for both 
statuses. This report will also include receipts that have been dummy invoiced. 

Unapproved PO Report: Lists all open PO’s which have not yet been marked as approved. This report can be 
run for a specific date range or it can be generated to include all unapproved purchase orders. 

Load Grid: To view the list, then click Print and/or Preview. 

Preview and Print: To print or preview the selected PO’s. 

Clear: The Clear button will clear the selections. 
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PO Status Report 

To print and/or preview Purchase Order Status report, use the filters below to return a list. 

 

 

Load Grid: To view the list, then click Print and/or Preview. 
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Preview and Print: To print or preview the selections. 

 

 

Export to Excel: To create an Excel file. 

 

Clear: The Clear button will clear the selections. 
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PO Accrual Report 

Non Invoiced Accrued PO Receipts - Select Load Grid to display data. 

 

Preview to preview a report.  Options include Print and Export. 
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In the PO Accrual report in .net purchasing added a prompt and field to entering a Cut Off Date. 

 

 

 

  



30  EFI PrintStream | User Guide 

 
 

 

Reports > Create Default Reports 

 

Create All Default Reports: To initalize or update Purchase Order reports. 

 

Yes 

 

OK 
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View All Reports: Select to view all Purchase Order reports. Double-click to select to specific report. 

 

 

The selected report displays in the field. 
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View Report Design: Select to view and edit the report in the report designer tool. The report designer tool will 
open the selected report for editing. For documentation regarding this feature contact your PrintStream support 
team, ask for the DexExpress Report Designer doc. 

 

 

 

Window > Cascade, Tile Horizontally and Vertically 

 

These are windows display features. 

Note This feature is in development. 
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Help > PO Line Legends 
 

 

Displays the icons which represent the various PO Line Types. 
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Help > About 

 

Displays various information and details about the .Net Purchasing module. 
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Purchase > New Purchase Order 
 

 

 

Select a Vendor by entering the first characters of the vendor name then select from the drop-down list. 

 

 

You can also enter/edit other fields as shown above as needed. 
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PO Header Fields 

Order #: System assigned next sequential number. Cannot be altered. 

Date: Defaults today’s date. May override. 

Ordered By: Defaults to log in users ID. 

Reference: Reference Number – optional field. Will print on the PO. 

Revision #: System generated revision Number. Tracks how many times the PO has been altered. Cannot be 
changed. 

Revision Date: System generated Revision Date. Will display the date of the last revision. Cannot be changed. 

Revised By: System generated Revised By. Will display the ID of the user whom did the last revision. Cannot be 
changed. 

Vendor: Number and name and address of selected vendor. Can change if needed (must be a valid vendor from 
Master File Vendor). Can select a different address for vendor by selecting the down arrow. 

Telephone: Entered in Master File Vendor. Cannot be changed here. 

Fax: Entered in Master File Vendor. Cannot be changed here. 

Currency: Reference only. Cannot be changed. 

Header Notes: Select … to enter Header Notes. 

Ship To and Address: Defaults from the plant customer in Master Files Reports > Production System > 
Plants. Click the … button to choose from the list of additional shipping addresses. 

Ship To Attention: Optional. Free Form field - Will print on PO. 

Ship Via: Optional. Free Form field - Will print on PO. 

 

Purchase Order Menu Options 

 

New Line: To enter a new line item to the purchase order, select PO Line Type for item to be ordered. 

Save: Saves newly added PO Line Items and subsequent changes. 

Delete Line: Removed selected PO Line. 

Preview: Display a preview of the PO. 

Print: Opens a dialog box to print the PO. 

Email: Sends an email to the Vendor. To setup PrintStream email capabilities, contact your Support Rep. 

Update Job Changes: This feature will take any changes done in the estimate and overwrite the PO changes 
such as notes, scripts, etc. 
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Types of PO Line Items 

 

 

Job Related Multi Item: Purchases directly tied to a job (e.g., Buyout/Subcontract). This option allows you to 
select multiple buyouts for one job to the vendor assigned to the purchase order. 

Job Related: (Single Item) Purchases directly tied to a job (e.g., Buyout/Subcontract). This option allows you to 
select one buyout at a time for one job. 

Non-Inventory: Expense immediately. Will not get used on a job (e.g., Office supplies). 

Paper Inventory: Has dollar value/asset account (e.g., Paper, Envelopes. Print system only). 

Finished Goods: Has dollar value/asset account (e.g., Binders, Diskettes used for a job). 

Material Inventory: Has dollar value/asset account (e.g., Raw Materials: Ink, Labels, Plates). 
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Job Related Multi Item 

1. Enter the Job # and Load Data button. 

2. Select (check) item(s) to be purchased. 

3. Enter the date required and the applicable tax code. 

4. Select Create PO Line Item. 

  

 The Job-Related line item purchase has been added to this PO. 
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Job Related (Single Item) 

1. Enter/search Job #. 

  

2. Click the Planned Purchases button. 

3. Select or double-click the item to be purchased. 

  



40  EFI PrintStream | User Guide 

 
 

 

4. The item purchase details will populate the screen. Enter other optional fields as needed and click Save 
Line. 

  

 

Non-Inventory 

1. Enter purchase details similar to what is shown below. 
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2. Enter an AP Code or search and select from this screen, select or double-click code. 

  

3. The AP Code, GL Code, and Tax Code will populate the screen. Click Save Line. 
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Paper Inventory 

This purchase order type allows the user to purchase paper inventory held in the warehouse and used for 
multiple jobs; not specifically purchased for one job. 

1. Enter/search for a paper item, enter a quantity, price, and other details as needed, and click Save Line. 

2. Click New Item to create a new paper item to be ordered. 

  

3. Select Stock Details to see quantities and pricing. 
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4. Click the Reservations button to see all jobs and quantities in need of this item. You can also check 
lines to order the item quantities to cover the job(s) requirements. 
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Finished Goods 

1. Enter/search for finished goods item, enter a quantity, price, and other details as needed, and click 
Save Line. 

2. Click New Item to create a new finished goods item to be ordered. 

  

3. Select Stock Details to see quantities and pricing. 

  

4. Click the Reservations button to see all jobs and quantities in need of this item. You can also check 
lines to order the item quantities to cover the job(s) requirements. (See Paper Inventory for screen 
details.) 
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Material Inventory 

1. Enter/search for material inventory item, enter quantity, price, and other details as needed, click Save 
Line. 

2. Click New Item to create a new material inventory item to be ordered. 

  

3. Select Stock Details to see quantities and pricing. 

  

4. Click the Reservations button to see all jobs and quantities in need of this item. You can also check 
lines to order the item quantities to cover the job(s) requirements. (See Paper Inventory for screen 
details.) 
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Prevent creating an inventory related PO line if Track Quantities is not checked  

New development prevents creating purchase orders if item is set up for Track Quantities is OFF. 

 

 

 

  



V21.1.0200 .Net Purchasing  47  

 
 

 

Purchase > Open Purchase Order 

 

 

Open Purchase Order will open the selected PO in the tree. 

 

 

  



48  EFI PrintStream | User Guide 

 
 

 

Purchase > Copy Purchase Order 

 

Copy Purchase Order will open the selected PO in the tree. 

 

Load PO: Loads the Po selected from the PO Tree. 

Copy: Copies the selected PO to a new PO. 

Clear: Clears the display fields in the screen. 

Cancel: Closes the Copy PO function. 
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Purchase > Clear PO Tree 

 

Select to clear PO’s from the PO Tree display. 

Before 

 

After 
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Purchase > Search Purchase Order 

 

Search: Enter PO # and Select PO or enter search criteria and select Search view a PO list. 

 

 



V21.1.0200 .Net Purchasing  51  

 
 

 

Select: Highlight PO to view/edit and select or double-click to select. 

 

Clear: The Clear button will clear the selections. 

Preview and Print: To print or preview a Purchase Order Status Report. 
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Export to Excel: To create an Excel file of the PO Search display grid. 
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Purchase > Preview 
To Preview the selected PO 

 

Purchase > Print 
To Print the selected PO 
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Purchase > History 

 

Displays a listing of PO’s. 
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Highlight a line and select Details from the menu or Purchase Order Details to view the PO Line Item details. 

 

 

Purchase > Exit 
Closes the Purchase Order module. 
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Purchase Approval 

 

PrintStream offers an approval process to approve purchase orders prior to previewing or printing them. This is 
an option setting defined at the plant level for each plant defined in the database. 
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To activate this feature 

1. Go to Master File Reports > Production System > Plants PO Approval Required. 

2. Select the PO Required check box if the facility requires ALL PO’s need approval. 

 DO NOT select if no approval is needed. 

  

3. Search for and/or enter a PO #, then select Yes in the Approval drop-down control. This will allow this 
PO to be previewed and printed. 

 

  Purchasing Approval can also be accessed as a stand-alone module. 
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Purchase Order 

Purchase Order > Create New PO 

 

Select a Vendor by entering the first characters of the vendor name then select from the drop-down list. 

 

 

You can also enter/edit other fields as shown above as needed. 

PO Header Fields 

Order #: System assigned next sequential number. Cannot be altered. 

Date: Defaults today’s date. May override. 

Ordered By: Defaults to log in users ID. 

Reference: Reference Number – optional field. Will print on the PO. 

Revision #: System generated revision Number. Tracks how many times the PO has been altered. Cannot be 
changed. 

Revision Date: System generated Revision Date. Will display the date of the last revision. Cannot be changed. 

Revised By: System generated Revised By. Will display the ID of the user whom did the last revision. Cannot be 
changed. 

Vendor: Number and name and address of selected vendor. Can change if needed (must be a valid vendor from 
Master File Vendor). Can select a different address for vendor by selecting the down arrow. 
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Telephone: Entered in Master File Vendor. Cannot be changed here. 

Fax: Entered in Master File Vendor. Cannot be changed here. 

Currency: Reference only. Cannot be changed. 

Header Notes: Select … to enter Header Notes. 

Ship To and Address: Defaults from the plant customer in Master Files Reports > Production System > 
Plants. Click the … button to choose from the list of additional shipping addresses. 

Ship To Attention: Optional. Free Form field - Will print on PO. 

Ship Via: Optional. Free Form field - Will print on PO. 

 

Purchase Order Menu Options 

 

New Line: To enter a new line item to the purchase order, select PO Line Type for item to be ordered. 

Save: Saves newly added PO Line Items and subsequent changes. 

Delete Line: Removed selected PO Line. 

Preview: Display a preview of the PO. 

Print: Opens a dialog box to print the PO. 

Email: Sends an email to the Vendor. To setup PrintStream email capabilities, contact your Support Rep. 

Update Job Changes: This feature will take any changes done in the estimate and overwrite the PO changes 
such as notes, scripts, etc. 

 

Types of PO Line Items 
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Job Related Multi Item: Purchases directly tied to a job (e.g., Buyout/Subcontract). This option allows you to 
select multiple buyouts for one job to the vendor assigned to the purchase order. 

Job Related: (Single Item) Purchases directly tied to a job (e.g., Buyout/Subcontract). This option allows you to 
select one buyout at a time for one job. 

Non-Inventory: Expense immediately. Will not get used on a job (e.g., Office supplies). 

Paper Inventory: Has dollar value/asset account (e.g., Paper, Envelopes. Print system only). 

Finished Goods: Has dollar value/asset account (e.g., Binders, Diskettes used for a job). 

Material Inventory: Has dollar value/asset account (e.g., Raw Materials: Ink, Labels, Plates). 
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Job Related Multi Item 

1. Enter the Job # and Load Data button. 

2. Select (check) item(s) to be purchased. 

3. Enter the date required and the applicable tax code. 

4. Select Create PO Line Item. 

  

 The Job-Related line item purchase has been added to this PO. 
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Job Related (Single Item) 

1. Enter/search Job #. 

  

2. Click the Planned Purchases button. 

3. Select or double-click the item to be purchased. 
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4. The item purchase details will populate the screen. Enter other optional fields as needed and click Save 
Line. 

  

 

Non-Inventory 

1. Enter purchase details similar to what is shown below. 
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2. Enter an AP Code or search and select from this screen, select or double-click code. 

  

3. The AP Code, GL Code, and Tax Code will populate the screen. Click Save Line. 
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Paper Inventory 

This purchase order type allows the user to purchase paper inventory held in the warehouse and used for 
multiple jobs; not specifically purchased for one job. 

1. Enter/search for a paper item, enter a quantity, price, and other details as needed, and click Save Line. 

2. Click New Item to create a new paper item to be ordered. 

  

3. Select Stock Details to see quantities and pricing. 
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4. Click the Reservations button to see all jobs and quantities in need of this item. You can also check 
lines to order the item quantities to cover the job(s) requirements. 
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Finished Goods 

1. Enter/search for finished goods item, enter a quantity, price, and other details as needed, and click 
Save Line. 

2. Click New Item to create a new finished goods item to be ordered. 

  

3. Select Stock Details to see quantities and pricing. 

  

4. Click the Reservations button to see all jobs and quantities in need of this item. You can also check 
lines to order the item quantities to cover the job(s) requirements. (See Paper Inventory for screen 
details.) 
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Material Inventory 

1. Enter/search for material inventory item, enter quantity, price, and other details as needed, click Save 
Line. 

2. Click New Item to create a new material inventory item to be ordered. 

  

3. Select Stock Details to see quantities and pricing. 

  

4. Click the Reservations button to see all jobs and quantities in need of this item. You can also check 
lines to order the item quantities to cover the job(s) requirements. (See Paper Inventory for screen 
details.) 
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Prevent creating an inventory related PO line if Track Quantities is not checked  

New development prevents creating purchase orders if item is set up for Track Quantities is OFF. 
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Purchase Order > Open Selected PO 

 

Open Purchase Order will open the selected PO in the tree. 
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Purchase Order > Search PO 

 

Search: Enter PO # and Select PO or enter search criteria and select Search view a PO list. 

 



72  EFI PrintStream | User Guide 

 
 

 

Select: Highlight PO to view/edit and select or double-click to select. 

 

Clear: The Clear button will clear the selections. 

Preview and Print: To print or preview a Purchase Order Status Report. 
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Export to Excel: To create an Excel file of the PO Search display grid. 
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Purchase Order > Purchase Approval 

 

PrintStream offers an approval process to approve purchase orders prior to previewing or printing them. This is 
an option setting defined at the plant level for each plant defined in the database. 
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To activate this feature 

1. Go to Master File Reports > Production System > Plants PO Approval Required. 

2. Select the PO Required check box if the facility requires ALL PO’s need approval. 

 DO NOT select if no approval is needed. 

  

3. Search for and/or enter a PO #, then select Yes in the Approval drop-down control. This will allow this 
PO to be previewed and printed. 

 

  Purchasing Approval can also be accessed as a stand-alone module. 
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Purchase Order > Copy Purchase Order 

 

Copy Purchase Order will open the selected PO in the tree. 

 

Load PO: Loads the Po selected from the PO Tree. 

Copy: Copies the selected PO to a new PO. 

Clear: Clears the display fields in the screen. 

Cancel: Closes the Copy PO function. 
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Purchase Order > Reports 

 

Purchase Order 

To print or preview a PO 

1. Select the Binocular icon to the far right of the Report Name field. 

 A report selection window opens. Double-click to select the desired PO format report. 
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2. Enter the PO number or click the Binocular icon to the far right of the PO #. 

 

  

3. Click Print or Preview to print or view the PO. 
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 Clear: The Clear button will clear the selections. 

 View Report Design: Select the PO Report Name then select View Report Design to open the report 
designer tool. 

 

  

 The report designer tool will open the selected report for editing. For documentation regarding this 
feature contact your PrintStream support team, ask for the DexExpress Report Designer doc. 
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Multiple Purchase Order 

To print and/or preview multiple PO’s, use the filters below to return a list of PO’s. 

 

 

Load Grid: To view the list of PO’s, then check the PO’s to Print and/or Preview. 

 

 

Preview and Print: To print or preview the selected PO’s. 

Clear: The Clear button will clear the selections. 



V21.1.0200 .Net Purchasing  81  

 
 

 

Inventory Stock On Order 

Stock on Order Report – this report shows the status on all paper items which are currently on order. It allows 
you to filter by PO date range and for all items, a specific item or by a specific vendor. Selecting the Include 
Items not Linked to a Job check box will include any PO’s that were ordered for inventory rather than for a 
specific job. 

To print and/or preview Inventory Stock On Order report, use the filters below to return a list. 

 

 

Load Grid: To view the list, then click Print and/or Preview. 
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Preview and Print: To print or preview the selected PO’s. 

 

 

Clear: The Clear button will clear the selections. 
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PO Monitor 

To print and/or preview Purchase Order Status report, use the filters below to return a list. 

 

 

Job Delivery Date Range: Date range is actually entered based on PO due date range not job delivery date. 

Job Status: Check for Not Final Shipped. 

Not Ordered: Displays a list of materials on jobs which have not been ordered. 

Final Delivered: Displays a list of PO’s which have been flagged as Finally Delivered. 

Waiting for Rcpt: Displays a list of PO’s which have not been received. 

Partial Delivered: Displays a list of PO’s which have partial delivery status 

All of the above selection types can be filtered by any of the following as well: CSR, Activity Code, Customer, 
Sales Rep, Job Number, Product Type, Vendor, and Estimator. 
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Load Grid: To view the list, check the lines to report on, then click Print and/or Preview. 

 

 

Preview and Print: To print or preview the selections. 

 

 

Clear: The Clear button will clear the selections. 
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PO Reports 

 

Overdue PO Report: Lists all PO’s that have not been received as final. It can be sorted by PO#, PO Date, 
Vendor Name or GL Code#. 

PO Receipts Accrual Report: Lists all PO receipts which have not yet been AP invoiced or dummy invoiced, for 
a specific date range. It can be sorted by PO#, PO Date, Vendor Name or GL Code#. This report is used to 
determine numbers for an AP accrual entry at month end. 

PO Without AP Invoice Report: Can be filtered for final and partial receipts, using specific date ranges for both 
statuses. This report will also include receipts that have been dummy invoiced. 

Unapproved PO Report: Lists all open PO’s which have not yet been marked as approved. This report can be 
run for a specific date range or it can be generated to include all unapproved purchase orders. 

Load Grid: To view the list, then click Print and/or Preview. 

Preview and Print: To print or preview the selected PO’s. 

Clear: The Clear button will clear the selections. 
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PO Status Report 

To print and/or preview Purchase Order Status report, use the filters below to return a list. 

 

 

Load Grid: To view the list, then click Print and/or Preview. 
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Preview and Print: To print or preview the selections. 

 

 

Export to Excel: To create an Excel file. 

 

Clear: The Clear button will clear the selections. 
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PO Accrual Report 

Non Invoiced Accrued PO Receipts - Select Load Grid to display data. 

 

Preview to preview a report.  Options include Print and Export. 
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In the PO Accrual report in .net purchasing added a prompt and field to entering a Cut Off Date. 
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Purchase Order > Create Default Reports 

 

Create All Default Reports: To initalize or update Purchase Order reports. 

 

Yes 

 

OK 
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View All Reports: Select to view all Purchase Order reports. Double-click to select to specific report. 

 

 

The selected report displays in the field. 
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View Report Design: Select to view and edit the report in the report designer tool. The report designer tool will 
open the selected report for editing. For documentation regarding this feature contact your PrintStream support 
team, ask for the DexExpress Report Designer doc. 

 

 

 

Scheduled Purchasing > Task List and Inventory 

 

These features are not yet developed. 
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PO Footer Set-up 

To include a note or comment on the footer of ALL purchases orders 

1. Go to Master File Reports> System Maintenance>Module Definition File. 

  

  

2. Select PO Defaults and Purch Order Footer. 

  

3. Save. 

 As a reminder, this will print on ALL purchase orders 
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Receiving Purchase Orders 

To receive a purchase order 

1. Launch Streamline.Inventory.Manager. 

  

  

2. From Transactions > Purchase Receipts, enter/search for PO #. The PO Line Items display. 
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3. Double-click a PO Line Item to select it; enter receipt details. 

  

 For more details regarding Streamline.Inventory.Manager and PO Receiving, please contact 
PrintStream Support and ask for Streamline.Inventory.Manager documentation. 
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PO Return 
The PO Return program is accessed by clicking the program located within the PO Return menu of the 
Transactions Main Menu in the dot-net Inventory Manager program. 

 

The program was created to return a Purchase Order Receipt to the vendor. When the program is opened, the 
screen that displays is ready for the user to enter the PO number of the received purchase order. 
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To complete a PO Return of a received purchase order 

1. Enter the PO # in the field at the top of the screen. 

 The first example is a purchase order for a purchased list. The screen displays the elements of the 
purchase order. 

2. Select the line in the lower screen to be returned and click the Return button. 

  

3. The PO Return Detail screen opens. Enter Return Quantity, Date, and Notes as needed then click the 
Return Now button. 
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4. Confirm the Vendor Shipping Address. 

  

5. Print/Preview Returns, Tickets, and Tags as needed. 

  

 For more details regarding Streamline.Inventory.Manager and PO Returns, please contact PrintStream 
Support and ask for Streamline.Inventory.Manager documentation. 
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Edit or Remove a PO Receipt 

To edit or remove a PO after it has been received or removed from the Scheduled Tasks list 

1. Open the Purchase Receipts screen and enter/search for the PO #. 

  

2. Right-click the line item and select Edit Receipt or Remove Receipt. 

  



100  EFI PrintStream | User Guide 

 
 

 

AP Invoicing PO Receipts 

Vendor Invoice for a Single Purchase Order Receipt 
Create a batch as described earlier in this document or continue working within an unposted batch. 

1. Create a new invoice by right-clicking the batch number and selecting New Invoice, or select Batch 
from the toolbar and select New Invoice. 

2. Define the invoice number, date, vendor, etc. There are two methods of how to invoice a purchase 
order receipt. 

3. After defining the AP Header screen, select Save Header. From the Invoice Lines tab, select the New 
PO Line button on the Invoice Line task bar. 

  

4. If the purchase order you are invoicing against was received elsewhere in PrintStream, select the Order 
Receipts option. 

5. In the Order field provided, enter the purchase order number, or with your cursor in the field, use the 
up/down arrow key on the keyboard to scroll through the available purchase orders. Once selected, 
press the Tab key, and the line items from the purchase order received elsewhere in PrintStream will 
display showing the receipt date, part or final receipt, quantity received and a description. If the receipt 
is marked as final, then you can proceed to invoice. 

 Any purchase order line item, or partial line item, that has been previously AP invoiced will not display 
for selection. 
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6. Select the purchase order line item by clicking it, and then click the Next button or double-click the line 
item. 
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7. Make any necessary changes and then select either Save, Start New Misc Line, or Save And New 
Invoice. The purchase order line item selected will pull through onto the invoice. 

Note You are able to edit the unit price, subtotal, description, tax code and dissection code fields for 
non-inventory, finished goods, material inventory, and paper inventory related purchase 
orders. The unit price, subtotal, description, and tax code fields can be edited for job related 
purchase orders. If edits are required to material inventory purchase orders, it is highly 
recommended the changes be made on the purchase order rather than at the time of AP 
Invoicing. 

 When the PO receipt address differs from that of the AP invoice, the Address field will have a red 
background and a warning message will display. However, this warning will not prevent the PO line item 
from being AP invoiced. 

  

 If you do not see a receipt, or the receipt is a partial receipt for the PO line item you are trying to enter, 
you may be able to receive it into PrintStream at the same time the AP invoice is entered. This is 
applicable for non-inventory and job related purchase order line items only. 

8. Selecting the Auto-Receive as Final option will display the PO line items that have not been received 
elsewhere. Enter the purchase order number in the order field provided or, with your cursor in the field, 
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use the up/down arrow key on the keyboard to scroll through the purchase orders available. Once 
selected, press the Tab key and the line items from the purchased order not received will display. 

  

9. Select the purchase order line item you wish to receive by clicking it, and then click the Next button or 
double-click the line item. 

  

10. Make any necessary changes and then select either Save, Start New Misc Line, or Save And New 
Invoice. The purchase order line item selected will pull through onto the invoice. 
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Note If the quantity you wish to mark as received is different from what was ordered, you should 
NOT do the auto-receipt from the AP Invoicing program. Use the Inventory Manager program 
to adjust the quantity received. 

11. Selecting the Auto-Receive Balance on Partial Receipts option will display the remainder of PO line 
items that have been partially received elsewhere. Enter the purchase order number in the Order field 
provided or, with your cursor in the field, use the up/down arrow key on the keyboard to scroll through 
the purchase orders available. Once selected, press the Tab key and the remainder of the PO line items 
partially received will display. 

  



V21.1.0200 .Net Purchasing  105  

 
 

 

12. Select the purchase order line item you wish to receive by single left clicking it, and then click the Next 
button or by double-clicking the line item. 

  

13. Make any necessary changes and then select either Save, Start New Misc Line, or Save And New 
Invoice. The purchase order line item selected will pull through onto the invoice. 

Note If the quantity you wish to mark as received is different from what was ordered, you should 
NOT do the auto-receipt from the AP Invoicing program. Use the Inventory Manager program 
to adjust the quantity received. 
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Vendor Invoice for Multiple PO Receipts 
Create a batch as described earlier in this document or continue working within an unposted batch. 

1. Create a new invoice as instructed earlier in this document. Define the invoice number, date, vendor, 
etc. 

2. Select the Start PO Lines option. 

 The Multi PO Selection window opens. 

  

Note The purchase order line transactions displayed in the above grid are the receipts made to 
purchase order line items. Purchase Order line transactions that have not yet been received 
into PrintStream will not show in the Multi PO Selection grid. 

 Line transactions displayed in red (as shown above) indicate the purchase order has been dummy 
invoiced in AR Invoice Entry, but the AR invoice has not yet been posted; in such case, the AP 
invoice cannot be entered until the AR invoice batch is posted or the Dummy Invoice is removed 
from the un-posted AR invoice. 

 Line transactions displayed in white indicate the address of the PO receipts is different from the 
address selected in the AP Invoice Header. PrintStream will provide a warning if one of these 
receipts is selected, however, it will allow you proceed with invoicing the receipt. 

 Line transactions displayed in yellow indicate the address of the PO receipts is the same as the 
address selected in the AP Invoice Header. 

 All received Non-Inventory, Job Related, Finished Goods, Material Inventory, and Paper Inventory 
purchase orders will display in the Multi PO Selection grid. 
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3. To select the purchase order line items you want to invoice, select the grey check box provided at the 
beginning of the line. 

  

4. After selecting the PO line items to be invoiced, click the Invoice the Selected Receipts button in the 
lower right corner of the grid. As the program reads through the purchase order lines you have selected, 
you will see the lines change in color to green. 

5. When the program has completed reading through your selections, click the X located in the upper right 
corner of the Multi PO Selection window. The purchase order line transactions will pull through onto the 
invoice line screen. 
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6. To edit a purchase order line transaction in the Invoice Lines tab, you can either double-click the line or 
you can highlight the line and select Edit Line from the Invoice Lines toolbar. 

7. After the changes have been made, select Save, Start New Misc Line, or Save and New Invoice. 

  

Note the Unit Price, Subtotal, Description, Tax Code, and Dissection Code fields can be edited 
for non-inventory, finished goods, material inventory, and paper inventory related purchase 
orders. Only the Unit Price, Subtotal, Description, and Tax Code fields can be edited for job 
related purchase orders. Edits at the time of AP invoicing is not recommended for valued 
inventory. Please make edits directly to the purchase order in Purchasing Entry. 

 Dissection/GL codes default according to the code reflected on the purchase order, not the dissection 
code defined in the Vendor’s Master File. 

 Changing the dollar amount of an invoice entered against a received inventory related purchase order 
may change the average price value of the inventory. 

 

 


